Crossman, Brenda L

1998

Framework of learner outcomes in information and technology lesson guide
FRAMEWORK OF LEARNER OUTCOMES IN INFORMATION AND TECHNOLOGY LESSON GUIDE

BRENDA L. CROSSMAN

B.Ed, University of Alberta, 1992

A One-Credit Project
Submitted to the Faculty of Education
of the University of Lethbridge
in Partial Fulfilment of the
Requirements for the Degree

MASTER OF EDUCATION

LETHBRIDGE, ALBERTA

August, 1998
Abstract

When new curricula is introduced teachers search for the most suitable resources created to use in their instructional program. With the recent release of the Alberta Education’s Framework of Learner Outcomes in Information and Communication Technology document, the process of deciding how to teach the outcomes is underway. Alberta Education has overseen the development of illustrative examples which teachers can use once students are familiar with the outcomes. However, some teachers need more background in order to facilitate the outcomes in their program as they have not had a lot of training in computers and technology. This project is centred around the creation, implementation, and modification of 10 lessons for Division II students. The lessons are useful for teacher reference and for instructional purposes.
Table of Contents

1. Introduction / 1
2. Reflections / 6
3. Journal Summations / 11
4. Conclusion / 17
5. References / 20
6. Appendices / 22
   Outline / 22
   Lessons 1 - 6 / 26
   1.01 Lesson 1, Recognizing How Different Mediums... / 26
   1.02 Lesson 2, Turning Technologies On and Off... / 29
   1.03 Lesson 3, Converting Files and Connecting... / 31
   1.04 Lesson 4, Using the Word Processor / 37
   1.05 Lesson 5, Writing Friendly Letters / 41
   1.06 Lesson 6, Writing Business Letters / 48

Skills Test / 56
Test Key / 58
Lessons 7 - 10 / 60
   1.07 Lesson 7, Creating a Children's Story / 60
   1.08 Lesson 8, The Spread on Spreadsheets / 64
   1.09 Lesson 9, The Data on Databases / 85
   1.10 Lesson 10, Using the Information Highway... / 97
Introduction

The term "technology" and subsequently, computers, is rampant in today's schools and workplaces. For my one-course credit culminating Master's of Education project, I have created lessons for grade four to six teachers (Division II) based on Alberta Education's Framework of Learner Outcomes in Information and Communication Technology document. The lessons I have included are links between basic computer and technological operations and the stated outcomes. They can be used by Division II teachers in order to provide students with background information and practice activities prior to assigning the illustrative examples Alberta Education has developed. Alberta Ed. has laid out, in these examples, what students should be able to do with technology and have prepared tasks, that when performed by the appropriate age group, will demonstrate required skills and abilities. My project is an intermittent set of lessons in that it is to be used after becoming familiar with the technology outcomes but before assigning illustrative examples. The lessons, in the Appendix, lay out what Division II teachers can do to get across some objectives of the outcomes. The lessons act as a guide for teachers and students toward reaching the level of mastery they will need in order to complete the tasks Alberta Ed. is preparing. When completed, these tasks reflect proficiency with the outcomes.

Alberta Education's initiatives for implementing its Technology Outcomes document include preparation as to when phases of the document are being delivered and where they can be integrated with curriculums. However, school boards and their staffs are to determine how students are to acquire the outcomes. Expectations for use of technology at all levels of schooling have changed significantly in the last 14 years since the Computer Literacy (Elementary) component of the Alberta Education Program of
Studies has been revised (Alberta Education, 1994). Yet little is available to elementary teachers as to how to make these changes. Bill 213, the School (Computer Instruction) Amendment Act has been set forth to ensure that the province's students and teachers possess a basic level of computer literacy. The objective of passing this bill is to amend the School Act so that Gary Mar is permitted to set provincial objectives in computer technology. Bill sponsor, MLA Judy Gordon, feels this area needs to be standardized, so that "no matter where students attend school there will be a basic standard" of computer instruction (Cassidy, 1998, p. A2).

Although expectations for computer instruction are becoming standardized, the reality seems to be, based on the Division I - III schools I've contacted in Central Alberta, that there is not a lot computer access available to students in grades 1 to 6 at this time. This is as a result of inadequate funding being provided for computer hardware and software in schools.

With the limited access students have to computers, I'm using whole-class computer lab time for instruction of basic computer functions which I have laid out in the form of 10 lessons for this project. Curriculum connections, which are crucial since the technology outcomes have been added to program content and nothing has been taken away, reinforce computer capabilities as well as concepts taught in other subject areas. Thus, this package of basic instructional plans in the Appendix is to be used as a starting point for teachers and students to refer to when achieving the stated outcomes in various contexts.

There is a lot of information on the technology outcomes and implementation schedules and how these are going to be addressed but the actual resources on “how to” teach these outcomes, for the average teacher, are limited. When working from a language
curriculum for example, teachers are usually familiar with expectations and have ample supports as to how to relay these objectives to their students. Yet with computer instruction, it’s more difficult for teachers, especially ones without a lot of background and formal training in the rapidly advancing and changing field of computers, to instruct their students on computer use - not to mention tie in present material with the new outcomes.

Most teachers have completed inservice training in some of the areas outlined in the Technology Outcomes document but are not at a level of proficiency in all strands. If they’re uncomfortable with applying spreadsheet functions, for example, themselves, they’ll experience further anxiety and frustration when trying to teach this component to students. I feel there is a need for a “user-friendly” step-by-step set of lesson plans to assist average Division II teachers in their instruction of the technology outcomes. My guide is for the elementary generalist who is expected to teach the technological outcomes yet has no formal computer experience.

Most of the resources I used were gathered piecemeal. I concentrated most of my research on internet and multimedia applications but only had time to develop lessons for more basic areas of computer operations so far. I put together my lessons using what I have learned from a variety of sources over the past 10 or more years during which I have been involved with computers. I tried many of the lessons I prepared with my own class. Personal practice and experience were considered throughout the development of this guide. To develop ideas as fully as I possibly could, I looked into what professional development consortia were working on, and what the A.T.A. is doing in this area. My school board has not officially planned for any reinforcement with regards to the
designing of materials for this document yet, but I am trying to network with other teachers who have an interest in this area and want to contribute ideas. A few teachers within my district have been involved in the Telus Learning Project or in the designing of the Illustrative Examples with Alberta Education. For the most part, I have found teachers to be either on the guru side of things with respect to technology, and applying it in their classrooms, or, they are feeling like they're operating from the knowledge base available in the stone age. This range seems to have resulted because educational opportunities in technological aspects have not reached all teachers, or else haven't been followed through by all teachers. Although teachers are at differing levels on the technological capabilities spectrum, we are trying to maintain a standard for students' learning, likewise with any other subject.

Resources were gathered from publishers who have developed material in this area (this ended up only being Scholastic for large scale preparations), committees working on anything that applies to the learner outcomes, and various other sources. I used relevant books and news articles that tied in the use of technology and schools, any resources already prepared and available, internet information, and examples of what is going on in other systems of education with respects to technology. Last but not least, I conferred with other teachers and gathered their ideas as to how they will go about putting together lessons for this document. My end product is an amalgamation of the most effective ideas I could find for implementing the stated outcomes meaningfully for grades 4 to 6 students. This package is for use by grades 4 through 6 teachers, depending on hands-on access to computers, as a source of introducing areas of the outcomes documents pertinent to this age level.
My project was created using the Macintosh platform because that's what we have available to teachers and students at our school. For the most part, my computer experience has been with Macs. ClarisWorks has been the program I've used the most. I found this combination to be very user-friendly and conducive to student learning. I have tried to keep the plans as open to other systems and programs as possible. I hope that the plans I've put together using the combination of Macintosh and ClarisWorks will be a form of assistance for other teachers when developing concepts and instruction in each of the key outcome areas.

This project is centered around ten lessons which are based on one of the three key categories found in the technology outcomes document. Reflections on the process of completing this project are provided before sections from the journal I kept when trying out the actual lessons with my class. Finally, a conclusion summarizes the main points I extracted throughout the formation of this project. Included in the Appendix is an outline with the relevant category for each of the lessons as well as the general and specific outcome the lesson covers. After the outline, the key category and general and specific outcomes are again laid out with each lesson.
Reflections

I started keeping a journal of how my students were doing during whole class computer instruction within a lab setting in January. Up until this point, they had been focusing on keyboarding, word processing, and some Internet activities during their weekly 40 minute lab period. I received a copy of the impending technology outcomes in January and disseminated them by the areas I thought would be manageable with my students based on their background knowledge and access to computers.

I initially intended to prepare lessons for grades 4, 5, & 6 classes even though I solely teach grade 4. The grades 5 and 6 teacher were very receptive to having me teach their classes but didn't feel comfortable/confident with teaching the lesson and then reporting back to me as to how it went. I was hoping I would be able to do some switching and also instruct and monitor a grade 5 and a grade 6 class using the outcomes as starting points but conflicting timetabling wouldn't allow for this. At my E.C.S. school there is over 420 students and one computer lab with approximately 26 computers in it - depending on how many are operational at any given time! Class sizes are usually below 25 which is good for general instruction but limiting when it comes to scheduling junior high course time and elementary slots in the lab.

Fortunately there is also a computer in each classroom. I have had students on each day for about 12 minutes and have also tried where each student gets an entire 40 minute period of use but only once a week. Each set-up has positives and minuses. When students only have 10 minutes to access a program and either create, or work on a file, they are limited with what they can do. Nonetheless, having some time using the computer daily is better for maintaining skills than only using it once or twice a week.

This brings up the issue of "haves" and "have-nots" which can be applied to
students and whether or not they have a computer at home, and to the number of computers schools have. Unfortunately this is a sensitive area with discrepancies as to how limited government computer monies are, and how people feel they should be, distributed. This results in inequity which is inevitable when the funding that is available considers student populations of schools and little else. Even though my school is better equipped than many, according to government standards, we have no multimedia software - our computer budget for anything beyond hardware is $500 per year!

Demographics for the community where I teach show that about 50% of the adult population have not completed high school. Less than 3% have a university degree. In my class, these statistics work in our favor as 3 parents are students. They and one other family have a computer at home for a total of 4 out of 24 or about 17% of my class "having". This has not created any noticeable advantages within the age group I work with. I have found though that the students with computers at home do more extensive research for projects, because they have extra chances to spend time on using the computer, and can access the plethora of information the internet and c.d. roms provide, often with parental supervision. That one-on-one assistance at home helps to improve any area of schooling. However, some students are just as successful without the extras, as is the case with the more adept learners. I have to also note that there are students out there with computer systems at home, which are more extensive than those found in schools, that the students primarily use to play (non-educational) games on.

I have prepared the lessons and assignments at varying levels - from the most basic, to ones which require some backgrounds - in order to provide each student in my class, and other classes, with an appropriate level task for his/her skills. As mentioned, I intended to prepare something for each grade in Division 2. When I was not able to field
test lessons with classes other than my own, I simply combined what I had into each outcome area. As a result, some areas have an example of more than one assignment. Having worked through preparing and teaching these lessons on my own, has given me an appreciation for a product such as Techworks. I also respect districts that continue to support committees and curriculum coordinators who create and compile resources for classroom teachers. Giving actual classroom teachers time and funding to prepare curriculum support material would be even more worthwhile and beneficial to teachers and students!

After having contacted Alberta Education’s Doug Knight about this project, I found out that thus far their agency is still developing the illustrative examples and scoring guides which are slated to be out in June. This consists of tasks, linked to the curriculum, which will help students and teachers to understand what a child could do to demonstrate proficiency with the outcomes and are in some way, assessment tasks. I worked with Doug Knight and a group of teachers and reviewed the exemplars. They are well set up and excellent links between technology outcomes and other curricular expectations. However, they are not meant to provide the "how-to" basics needed to complete the tasks. At this time Alberta Education has no plans to develop resource or course material that would relate to the framework, although such material is needed, according to Mr. Knight. He also noted that they may approach publishers who have an interest in developing resources but there is not certainty at this time that they will do anything, or when they would do it. Scholastic has a package called “Techworks” out which I have previewed for "level" 4 students. I wouldn't be doing this project if there was a better fit between the technology outcomes and lessons plans currently available.

Scholastic’s Techworks was prepared by a writer who holds a Master of
Education degree and has the necessary background in technology as well. The major drawbacks of the kit are the cost, and the fact that, like many resources, it is adapted to the Alberta Education’s Framework of Learner Outcomes in Information and Communication Technology but not made specifically for it. *Techworks* provides a Scope and Sequence of what skill to introduce, master, and extend at each level. Comprehensive rubrics are provided for each area. The curriculum matrix section merely provides a breakdown of which subject area certain activities fall into. This does not correspond directly with actual grades 4 - 6 curricular topics though. This discrepancy occurs with resources in other subject areas as well. Teachers are required to modify and check where and how each lesson matches outcomes/objectives. This is time consuming and expensive considering the cost of purchasing resources which are only useful in part. Furthermore, with *Techworks* trying to suit every school's needs, a lot of details are missing in their plans with respect to different programs.

Parental support is another area *Techworks* delves into. In order for this to be relevant, parents have to be involved at the school level and working on technology outcomes with their children at home. Both these variables depend on whether or not parents are working, and if parents have a computer at home or use one in their workplace.

With schools across Alberta in less than equitable positions, the outcomes have to be approached from a best possible standpoint within the context of what one's working with. Not only are students working with different platforms and software, teachers are at various levels with regards to their computer literacy background and confidence in using them, much less teaching computer based lessons. These plans are basic and can be used by teachers to try various capabilities offered by computers, while
they guide their students through these concepts. With a strong start to the technology outcomes, students and teachers are setting themselves up for success - a positive experience, and opening the door to a lot of new learning potential and possibilities.

Publishers provide complete, impressive packages and materials. Even if a teacher or school is piloting these resources, they are not their own, and a valuable process is lost - the designing and carrying out of plans is not complete. Ownership and understanding is missing. Time constraints are the obvious reason why teachers are not able to do this more often. This project allowed me to take more time to work through this resource than I would have normally done so. My project is directed at a small test group because that’s with whom I work, whom I intended it for, and wanted it to work for. Based on where I was coming from and where students and other teachers in my school were at, is where this started.
Journal Entry Summations

Week of January 26-30

Lesson 1 (Appendix B) was introduced and worked on initially in the regular classroom. Example activities were completed and students brainstormed ideas and responses during a Language period. Students were given time to create an advertisement using text only, drawings only, and then a combination of both. They transferred this experience by making "business" cards for themselves. Students quickly recognized how different texts and graphics can be more appealing than others and enhance and alter perception. Later that week, when we had a computer lab period, students used what they had worked out on pencil and paper and transferred it onto the computer. Computer capabilities helped students to take their original draft, refine it, and create a more complete work. Using more Language time, we are also working on creating commercials which will require awareness of sound and how it affects perception and communication.

February 2-13

We had parent-teacher interviews and teachers' convention the first week of February. As a result, we missed a computer lab period. The students continued to work on their commercials in the classroom during some Language time. The novel study we are completing at this time, "Tales of a Fourth Grade Nothing", also coincides with this assignment.

The second week of February was when students went to the office, library -
where the fax machine is located, and other rooms where technologies are. This (Lesson 2, Appendix C) was set up like centres. Being that the students were in groups of 4, each demonstration of powering up and down the machine only had to be done 6 times. I don't know if it's good for the machines but it gave the students a chance to see and try how to turn various technologies on and off correctly. The computers in our laboratory are usually left on at all times. Therefore, when in the lab this week, the students went through how to turn the machines off, and then back on again. Peripherals, such as printers, are always on. The students already know how to print files, how to log on the server, and what passwords are required for certain programs they need to access.

With my class, we have been using the keyboarding program "All the Right Type". Each lab period students spend up to 10 minutes refining their skills in this area. Some computer stations in our school's laboratory also have the keyboarding program "Mavis Beacon" on them but I haven't used it with my class. Students who are not using appropriate techniques also have to devote their classroom computer time to this. We worked on keyboarding for almost 10 weeks in the fall but one class a week is not enough for students to retain and improve their skills. Even the few students with computers at home seldom use them for keyboarding drill and word processing exercises. I realize that voice activated and other types of computers which don't require keyboarding for word processing exist. With school children, keyboarding helps them to develop fine motor skills and coordination. Also, technology available to schools is usually years behind what is found within other industries. Keeping this in mind, keyboarding will be a necessary skill for students to develop for some time. Unfortunately, at our school, only the junior high students get sufficient time to advance in keyboarding.
February 16 - 20

Lesson 3 (Appendix D) served primarily as a teacher-direct review of word processing concepts. Most of the functions had already been covered in the first part of the year. Students still enjoyed the opportunity to experiment with features and needed some fine tuning of their word processing techniques. The four students with computers at home have IBM compatible systems. We have converted various files with them but this lesson gave the rest of the class an opportunity to see how this process took place.

February 23 - 27

Lesson 4 (Appendix E) combined what we were working on in the first lesson and what we did in Lesson 3. The class really enjoyed working through this exercise and benefited from the word processing and graphics practice. A lot of the steps had to be demonstrated and students had a hard time following all the instructions on their own. In this case, I worked with as many as I can and also have students help each other through more difficult parts.

March 2-6

Students had already completed personal/friendly letters at Christmastime to enclose in cards. This week we reviewed the personal letter format as we will be writing letters to pen-pals/students in Quebec as part of a Social Studies unit. Lesson 4 is a good lead in to Lesson 5 (Appendix F) when completed before December. As well, toward the end of the school year, for Health, students write letters to their next year's teacher and upcoming students. All of these letters can be completed on the computer.
March 9 -13

We worked on the Quebec penpal letters. Most of the first draft had already been completed on paper and the students used this time to copy them out on the computer. Students work at very different rates therefore many had to use classroom computer time to complete this even though the letters were only a few paragraphs long.

March 16 - 20

We used a second class period to complete the Quebec letters. Those who were finished got to use the tool palette and create drawings of their house and neighborhood to add to their letter.

March 23-27

For Lesson 7 (Business Letter - Appendix H) we followed the assignment as closely as possible. After having worked through these instructions with grade 4's, I think the steps are more appropriate for a grade 6 level. We used two lab periods to cover all material even though we had done a lot of it before. For the most part students knew how to delete text and copy and paste. Using the business letter format was a new concept as we had only done personal letters up until this point.

April 6 - 9

"Waste and Our World" is a Science Unit in grade four. We wrote to various environmental agencies and businesses using what we had learned in Lesson 7 and Science classes. We also use some Language time in order to complete these before Easter. We were hoping to get some responses by the time we returned from Easter break.
April 20 - May 8

Upon returning from Easter, we reviewed what we had learned about text so far. I then gave the students the enclosed test and was impressed with the results considering how long they had been away from the computers.

We then went onto something more enjoyable and started to work on children's stories in Language. I then used 3 computer periods to complete these as the students have not had the opportunity to formally use the painting and drawing functions all year. One difficulty we encountered after working on this for a period was that disk space was very limited - more so than I had even realized when I made up the warning in the assignment. Students have their own space through the server. We worked around this by having students use floppy disks too. Another concern was that we don't have a colored printer so the final product was not exactly what the students had developed on the screen. Some chose to color their own work on hard copies so that it wasn't black and white.

May 11 - 15

We worked on spreadsheets and databases somewhat in the fall. Information from Lessons 7 & 8 (Appendix I) was used. This past week the students completed a spreadsheet and graph using garbage contents as data. We then started a spreadsheet on plants and their growth based on another Science Unit. I was really impressed at how quickly many were able to enter data and manipulate it within a spreadsheet environment. Others needed coaching on how to open a new spreadsheet file from ClarisWorks. It's a constant struggle in a regular classroom to be prepared for the advanced students while
assisting those who need remedial instruction and the same goes for technological applications.

Next I will be reviewing databases with the class and then moving into Internet applications. I still haven't received acceptable use policy permission slips from a few students but hope that all students will be able to participate in the hands-on activities I will be creating. I feel that using the internet meaningfully in education is one of the most important connections we have to make in order to prepare students adequately for the future. I should mention that students have been using internet capable stations in the library, the lab, and at home to research various topics throughout the year. We're a little behind the schedule I hope to implement next year in which multimedia and internet applications are the focus of computer instruction from December on. HyperStudio software should also be available within our school by next fall. In the meantime I have had the kids work on video projects as a replacement for computer-based multimedia projects.

Each year students are further in front of the starting point as they come with more advance learning. Exposure to and experience with computers is slowly but surely making its presence. It's hard to keep on top of rapidly advancing technological capabilities as a teacher even when reviewing relevant sources. Passing on basic skills and trying to relay the most pertinent information is the best we can do to pave a strong foundation with elementary-aged school children considering the limited equipment available to them.
Conclusion

Everything took twice as long as I had expected. With restricted access to computers, only so much can be accomplished by students who have limited exposure to computers and other forms of technology. I feel the students are doing very well considering. They are very eager and often make discoveries as to how things work on their own. After reviewing my more extensive journal notes, I found that many of the students were not able to retain from week to week all objectives of the lessons I went over. I often found myself reteaching certain concepts over and over throughout the 12 or more weeks I kept track of students' progress more thoroughly.

I did not complete this project in order to question the outcomes and their inevitable inception in our schools. In my experience of having to implement computer technology, all types of technological changes have already taken place in schools. A lot of headway has already been made yet most progress has not been recognized up until this point. The technology outcomes will enhance, monitor, and secure what has happened so far. The reason advancement has been so tentative with the delivery of the outcomes is because there has not been consistent financial or technical support to carry it out. The government proposed allocating millions of dollars for this area of education. Initially the public and educators felt there would be enough funding to support this technological movement. Anything with adequate financial backing is usually viewed as being positive, or at least feasible. Of course there are always a few teachers who are scared of change, or more so, I think, of the unknown. However, with supportive leadership, direction, guidance, modelling, and time, these tentative followers too come around. Some schools have hired new teachers based on their computer background. The knowledge and attitude components are in place. Progress seems to have been primarily
stifled because most schools have a limited budget and cannot afford to allocate the large number of dollars necessary for constant computer upgrades. The impact of computers in classrooms has depended on how the financial strain which technology creates has been managed. It's hard for most educators (in Division II at least) to stay motivated with regards to the computer movement when the world of authoring software is advancing so quickly and many students and teachers at this level don't even have access to basic programs. However, making the best out of available resources has proven successful. The lessons I have created met the needs of my students and fulfilled the stated outcomes to the best of our abilities. Although the lessons are not based on state of the art equipment or software, they provide students with various learning opportunities. Any exposure to computer possibilities allows students to experience technologies available to them at this time and creates an openness to future capabilities.

I believe that change is a constant, and know it is inevitable and necessary in order to prepare ourselves and students for the future. I have also learned by getting involved in this project that seldom tasks of this magnitude come about easily, or on schedule. Working on creating and testing resource material has been a fulfilling experience, yet very demanding. I now know, firsthand, why, when curricular changes occur, education is big business, especially for publishers. Although kits like Techworks are very expensive, it's easier and less time-consuming to purchase them than to put together background information, lessons, and activities, and assessment ideas while teaching. Teachers are also expected to constantly prepare for curricular changes in other subject areas. Curriculum coordinator positions and other areas which used to be found within most boards have been downsized, if not eliminated altogether. Meanwhile, new material constantly needs to be evaluated and added to school programs. Without appropriate
funding and assistance however, the transition from old to new, or then and now, will not be smooth, or as successful, as intended. Teachers cannot be expected to do it all, nor can those few left implementing the ideas of Alberta Education.

Completing this project has been a worthwhile and insightful experience even though the relevance of the majority of the work will be shortlived. Inherent in completing any task connected to technology, is that by the time one has finished a project, if not before, computer capabilities have advanced beyond what one was working with. The lessons I have completed no longer apply to state of the art technology. However, with elementary education, the equipment found in schools will most likely never equal what is available on the cutting edge. The learning curve involved with technology is constantly evolving. Therefore, what I have experienced and am trying to instil in my students is continual growth and lifelong learning. I'll be able to continue with, and add to my project, through ongoing professional development - making it the dynamic, ongoing, and ever-changing document it needs to become in order to advance alongside the fast paced technological movement. With the development of the Technology Outcomes, Alberta Education has unleashed an unprecedented embedded curriculum which should become a priority in all areas of study. Technology needs to continue to be a major focus, no matter what the cost, of education in order to keep program content on the right track and prepare students for the 21st century.
References


http://www.schoolnet.com/
Appendix

The following includes an outline which provides a title and general and specific outcomes for each of the lessons provided in the Appendix.

OUTLINE

Key Category: *Foundational Operations, Knowledge and Concepts*

**LESSON 1  Recognizing How Different Mediums and Technological Capabilities Enhance Perception / 29**

General Outcome:

F4. Students will become discerning consumers of mass media and electronic information.

Specific Outcomes:

2.1 recognize that graphics, video and sound enhance communication

2.2 describe how the use of various texts and graphics can alter perception

**LESSON 2  Turning Technologies On and Off and Everything In Between / 32**

General Outcome:

F6 Students will demonstrate a basic understanding of the operating skills required in a variety of technologies.

Specific Outcomes:

2.1 power up and power down various technologies and peripherals correctly

2.2 use and organize files and directories

2.3 use peripherals, including printers and scanners

2.4 use appropriate keyboarding techniques for the alphabetic and punctuation keys
Key Category: *Processes for Productivity*

**LESSONS 3 - 6** Converting Files and Connecting Various Features with Word

**Processed Letter Writing / 34**

General Outcome:

P1. Students will compose, revise and edit text

Specific Outcomes:

2.1 create and revise original text to communicate and demonstrate understanding of forms and techniques

2.2 edit and format text using such word-processing features as the thesaurus, find/change, text alignment, font size and style to clarify and enhance meaning

2.3 convert digital text files by opening and saving them as different file types.

Skills Test / 59

Test Key / 61

Key Category: *Inquiry, Decision Making and Problem Solving*

**LESSON 7** Creating a Children's Story / 63

General Outcome:

I7 Students will use electronic research techniques to construct personal knowledge and meaning.

Specific Outcome:

2.2 use selected presentation tools to demonstrate connections among various pieces of information
Key Category: Processes for Productivity

LESSONS 8 & 9  The Spread on Spreadsheets & The Data on Databases / 67

General & Specific Outcomes:
P2  Students will organize and manipulate data.
2.1 enter and manipulate data, by using tools such as a spreadsheet or database for a specific purpose
2.2 display data electronically through graphs and charts

P4  Students will integrate various applications.
2.1 integrate a spreadsheet, or graphs generated by a spreadsheet, into a text document
2.2 vary font style and size, and placement of text and graphics, in order to create a certain visual effect

Key Category: Inquiry, Decision Making and Problem Solving

LESSON 10  Using the Information Highway Effectively / 100

General & Specific Outcomes:
I1. Students will access and use information from a variety of technologies.
2.1 access and retrieve appropriate information from the Internet by using a specific search path or given uniform resource locations (URLs)
2.2 organize information gathered from the Internet or an electronic source by selecting and recording the data in logical files or categories
Students will seek alternative viewpoints using information technologies.

seek responses to inquiries from various authorities through electronic media

In general, most areas will be introduced and attempted in grade 4. Grade 5 will entail reviewing, being introduced to any areas not covered in grade 4, and going beyond what was accomplished in grade 4. Grade 6 will consist of any missed objectives and taking outcomes and demonstrating a thorough understanding of concepts covered from grades 4 - 6.

Curricular links would allow for some lessons to be incorporated into various subject areas. Lessons would not necessarily have to be conducted in a computer lab. Demonstrations could take place with only one station in place and discussion could occur in any setting.
LESSON 1

The outcome of "Students being discerning consumers of mass media and electronic information" was very conducive to an introductory lesson on what technologies are capable of and how they affect perception. Awareness of computer functions and their inherent results is embedded within the Language curriculum. Students get to view various communique and then create their own.

Key Category: Foundational Operations, Knowledge and Concepts

Recognizing How Different Mediums and Technological Capabilities Enhance Perception

General Outcome:
F4. Students will become discerning consumers of mass media and electronic information.

Specific Outcomes:
2.1 recognize that graphics, video and sound enhance communication
2.2 describe how the use of various texts and graphics can alter perception

Motivation:

Write on black/white board the above objectives. Discuss how movie scripts are created and put down on paper, show a picture book and a book with text only. Watch a video/T.V. program without sound. Also listen to the sounds without watching.
Lesson:

Only the final assignment of this lesson requires computer lab time. Talk about how different mediums and technological capabilities enhance perception and are more captivating based on the motivational activities above and other experiences students have had. Compare this concept to printing/handwritten text and how different samples are easier to read. Title pages/book covers are another example of that kids are familiar with of how a title can be more than just words. Also note how different examples appeal to different people. Have students consider presentations, even teacher directed lectures/lessons they have either given or heard. What is more appealing? Keep in mind that 50% of material that is heard and seen is retained. As well, visual and auditory learners will both benefit from graphic/video/sound communication modes. Review favorite videos and discuss why they’re appealing. Talk about advertising - billboards, commercials, newspaper (often black and white) to magazine ads. Go over graphics sections and use of MacGalleryClip Art or other graphics' databases.

Advertising makes a business of adapting a message and its meaning to catch the audience’s attention. Curricular links include composing a piece of work to suit a particular audience and enhancing it to catch the viewer’s attention. Demonstrate information/message/text without graphics/video/sound (whatever capabilities available) and with.

Guided Practice:

Have students create message with text only and then have them modify it using various fonts and texts. Let them explore different fonts, sizes, styles and positions. Have them add graphics and practice placing these on their work. This could be done with pen and paper if no computer time is available.
Tasks:

The final assignment would be to create a business card, pamphlet, poster, or magazine advertisement design using the whole page for the template. At least two graphics would be required.

Assessment:

A rubric or checklist could be used to observe student understanding with regards to discussion topics. Effectiveness and subsequent evaluation of the final assignment would be based on whether the piece had appropriate text and graphics within a suitable layout so that it was visually appealing and got a message across at the same time.
LESSON 2

After having viewed and created items using technologies in Lesson 1, students will now learn more about the basic operation of technologies. This ranges from turning power on, to improving keyboarding, and organizing work.

Turning Technologies On and Off and Everything In Between

General Outcome:

F6 Students will demonstrate a basic understanding of the operating skills required in a variety of technologies.

Specific Outcomes:

2.1 power up and power down various technologies and peripherals correctly
2.2 use and organize files and directories
2.3 use peripherals, including printers and scanners
2.4 use appropriate keyboarding techniques for the alphabetic and punctuation keys

Lesson Areas:

2.1 Go through the steps in turning on or starting on the computers at your school.

Beyond turning a computer on and off, students should be aware that if a machine freezes, it should be restarted by using the control, open apple and top right arrow keys instead of using the switch at the back. Other technologies students could learn to power up and down may be photocopiers, fax machines, overhead projectors, ghetto blasters, televisions, and V.C.R.s. Set this up as centres. Ideally some of the technologies could be demonstrated and monitored by support staff such as the secretary, librarian, and teacher aide.
2.2 In order to create files, students must be prepared to use a floppy disk or access their disk space on the network (i.e. Waterloo MacJanet). A new folder is selected under new folder and titled for what area the student is working on - database, etc. Database files already created can be dragged into this particular folder now.

2.3 Use printers and scanners as applicable in classroom/lab/school setting. Most labs have individual computer stations set up so one, two, or a few printers accommodate them. It is usually relatively easy to select a printer and complete a printout of what is required. If not sure about this area and no one is able to show you the steps, follow your system's accompanying manual for instructions on how to operate printers and peripherals.

2.4 - ongoing

Depending on amount and frequency of access to computers in a lab setting, instead of focusing on keyboarding as one course component or segment, you may have students spend first 5 - 10 minutes of a period on keyboarding in order to keep skills constant and even improving. For example, homeroom exercises might be kept very simple and include typing a letter with the left hand and then one with the right hand (ffjjff...). There are various keyboarding instructional programs as well as internet sights which can be used with little teacher preparation. If students are using an individual classroom computer or pods, some time should be spent on keyboarding regularly to keep proper techniques fresh in their minds.
LESSON 3

The next four lessons are based on the same outcome in which students are to compose, revise, and edit text. Students become more familiar with the capabilities of a word processing program and then use various functions to complete letter writing assignments which are also part of the Language curriculum requirements. At the end of this section a sample skills-based test is provided.

Key Category: *Processes for Productivity*

**Converting Files and Connecting Various Features with**

**Word Processed Letter Writing**

General Outcome:

P1. Students will compose, revise and edit text

Specific Outcomes:

2.1 create and revise original text to communicate and demonstrate understanding of forms and techniques

2.2 edit and format text using such word-processing features as the thesaurus, find/change, text alignment, font size and style to clarify and enhance meaning

2.3 convert digital text files by opening and saving them as different file types.

*Teacher Directed Introduction/Review* - for students who are new to creating documents using text properly with computers. Part of this lesson will be a review from the more explorative, opening lesson. Each of the above features will be explored and practiced. As well, a corresponding assignment will be completed. Conversion of files will also be introduced.
Step by step instructions can be displayed using an L.C.D or overhead projector. Chalk or whiteboards can also be used to outline any steps.

For example:

Today we are going to start learning more about word processing features on the computer. You will be using the typing skills we have practiced thus far. Start by opening ClarisWorks* from the Launcher and selecting “word processing”.

*Lessons will have to be modified according to the software each computer has loaded.

The following may not be necessary except for some grade 4 students who are not familiar with typing etiquette.

Now that you can keyboard in isolation, you need to apply it to your work. Before you begin, we have to go over a couple things about typing

Once you feel comfortable with how to space and justify a sentence, start typing out a goal for the school year or a New Year’s resolution (depending on the time of year).

Now, you can proofread/peer edit your entry. Furthermore the computer can help you check over your writing but it won’t catch all mistakes. For example, word substitutions (i.e. you instead of your) will not be recognized. As well, homonyms will not be differentiated. That is way you have to "red" over "you’re" work extra "car fully"!

Let’s see what the computer picks out for mistakes in the above using the spelling check. Do you see any other areas that need attending to?
Now, check your work over for spelling mistakes using the computer's spell checker. Select the Edit command from the menu bar (shown above) at the top of the screen.

Go down to Writing Tools and slide your mouse over to Check Document Spelling. Another way of accessing Spelling is to go to File from the menu bar and down to Shortcuts where you click the ABC red check mark box in the bottom left hand corner.
The next feature we will cover is the **Thesaurus** and is also found within the **Writing Tools** section underneath **Edit**. Let’s look at my introduction to this lesson.

Just like with an ordinary book thesaurus, you have to decide what word you have overused and then look for it. The computer does not decide which words to look up and suggest replacements for you as is the case with spelling.

Lastly, this helpful tool will be good for when you’re doing a database of addresses using names. You may realize after typing in a spelling of a name or certain word that is was wrong and want to change it. Instead of looking through your whole document for the name, you can simply once again go under **Edit** and down to **Find/Change**.

![Find/Change feature](image)
For example, take the word *resolution* from your writing and change it to the word *change*.

If you were going to save this text, you would also go to **File**. At **Save As...** you would type in a title for the document.
Now, if you were going to work on the story at home, or somewhere that it’s an IBM and not a Macintosh computer, you would have to change the file type in order to convert the information. It’s just like writing a story in English and then giving it to someone who only knows French. The story has to be translated or changed. Likewise, if you bring in a story from home that was written on a different type of computer, you can only read it within this computer’s language. Thus you would also have to open it by going to **File Open...** and going under **File Type** to decipher the codes and make them readable.

<table>
<thead>
<tr>
<th>Show Preview</th>
<th>Document Type</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>All Types ▼</strong></td>
<td><strong>ClarisWorks ▼</strong></td>
</tr>
</tbody>
</table>
LESSON 4

This lesson is based on the same outcome as Lesson 3 in which students are to compose, revise, and edit text. Students become more familiar with the capabilities of a word processing program and then use various functions to complete letter writing assignments which are also part of the Language curriculum requirements. This section can be made into a handout or displayed from the teacher's computer so the steps can be worked through together.

Key Category: *Processes for Productivity*

**Converting Files and Connecting Various Features with Word Processed Letter Writing**

General Outcome:

P1. Students will compose, revise and edit text.

Specific Outcomes:

2.1 create and revise original text to communicate and demonstrate understanding of forms and techniques

2.2 edit and format text using such word-processing features as the thesaurus, find/change, text alignment, font size and style to clarify and enhance meaning

2.3 convert digital text files by opening and saving them as different file types.
**Using the Word Processor**

Most of you are quite familiar with the ClarisWorks 4.0 Word processor. Today’s lesson will give you some more practice with a few special functions.

**Getting Started:**

- To begin working with the word processor, open a new ClarisWorks word processing document.

- Go to the *View* menu and scroll down to *Show Tools*. A tool palette will appear on the left hand side of your document.

- Your first task is to create a cover page for your Report Card Portfolio. (Can be use for any type of Title Page/Book or Report Cover)

- Your cover page must include the following:
  - Your name
  - Library Clip Art
  - MacGallery Clip Art
  - Performa Clip Art
  - Border

- First, type in your text (name). Put it in the Font of your choice, fairly large. Also use some of the Style features.
Go to the File menu and select Library, Business Images. Select the clip board.

On your tool palette on the top left hand side of your screen, click on the arrow key.

Then click use on the Business Images file and situate the Clip Board or graphic of your choice (a binder is shown above) somewhere on the screen. Next:
Grab the handles (the small black squares) and resize the graphic. Then grab the middle of the clip board with your mouse and move it around.

Make the clip board slightly larger and place it somewhere towards the bottom of your page.

Somewhere on the page type, “Blackfalds School”, in about size 12 font. It doesn’t matter where you type this as you will be moving it.

Highlight “Blackfalds School”. Go to the Edit menu Cut or use the shortcut way.

Click on the tool palette arrow. Go to the Edit menu -> Paste.

The words will reappear with toggles around them. Now, move the words over top of the clip board. Readjust the size so it fits into the clip board.

You may also have to readjust the size of the clip board. Change the font and style of the words in the clip board/graphic (a binder).

Carry on with your cover. Macgallery and Performa Clip Art are located in the Documents Folder under hardrive.
LESSON 5

This lesson is based on the same outcome in which students are to compose, revise, and edit text. Students become more familiar with the capabilities of a word processing program and then use various functions to complete letter writing assignments which are also part of the Language curriculum requirements.

Key Category: Processes for Productivity

Converting Files and Connecting Various Features with Word Processed Letter Writing

General Outcome:

P1. Students will compose, revise and edit text

Specific Outcomes:

2.1 create and revise original text to communicate and demonstrate understanding of forms and techniques

2.2 edit and format text using such word-processing features as the thesaurus, find/change, text alignment, font size and style to clarify and enhance meaning

2.3 convert digital text files by opening and saving them as different file types.

LESSON 5 (Gr. 4) - Health and Language Arts Related Activity

Objectives:

Curricular links - Explore and learn the personal letter format

Technology perspectives - Font, sizes, spelling, find and change
Student Instructions:

Type a letter to a grade 5 student or a grade 5 teacher. In your letter, you need to introduce yourself. Mention what skills you already have that you think will be useful in grade 5. Tell them about any concerns you have. Lastly, ask any specific questions you may have about gr. 5. Remember to use the following format when completing your letter. Save your work as “Personal Letter”.

Another friendly letter idea is to line up penpals in Quebec and have students in grade 4 write letters as part of their Social Studies unit.

Your letter must follow the above instructions and meet the following criteria:

a. The letter must be created following the personal letter format.

b. The letter must be approximately 3/4 of a page in length.

c. Spelling and other language mechanics must be checked.
Personal Letter Format

A personal letter should include essential details:

- the date
- a greeting
- a body
- a closing.

Layout example to follow:

(Date)
8/27/98
Dear **********,  (GREETING)

*******************************************************************************
*******************************************************************************
(BODY)
*******************************************************************************
*******************************************************************************
*******************************************************************************
Your Friend,  (CLOSING)

"Gummy"
When finished the above, change the font of the entire letter to Courier. Try others if there’s enough time. Now change the font size of the body to 9, to 13.

Change the student or teacher name you have selected to “Big Bird”. (You will have to use the Find/Change function). Change every second Big Bird to Oscar the Grouch. Finally, change every Big Bird and Oscar back to the original name! Check over your work carefully so you can forward it to the appropriate teacher's email address or deliver it to a grade 5 student in person.
Lesson 5 (Gr.5 or 6)- Friendly Letter Curriculum Requirement

Writing a (Friendly) Letter

Around Christmastime it is nice to send out letters which go into more detail than one generally writes in a card. Doing this for your family could be part of your mom’s Christmas present. If we have time we’ll learn the “Mail Merge” function so you can personalize these letters as well.

In order to enhance a word processed letter, you can include clip art. When using the clip art in this exercise, experiment with the selections under the Arrange menu to flip your clip art and move it from front to back.

Once you open a new Claris Works word processing document, do the following:

- Go to the Format menu, Insert Footer (NOT FOOTNOTE!!).
- Go to the Edit menu, Insert Page #, Click OK
- This will automatically number each of your pages.
- Click the cursor on the left hand side of the page number and type “page”.

This will automatically appear on each page.
- Scroll down and check it out.
- On any page, highlight the footer (page 2) and change the font and size of font.
- Headers work the same way. Try it out.
Another activity for students who are on track and have time to enhance their letter is for them to use the tool palette and draw and label a picture of their house and neighbourhood (see quick example).
December 1, 1997

Dear Friends and Family,

Here’s a quick note to update you on our family’s events over the past year. This is Mike. I’m writing this because I have to for a school assignment!

Mom is still enjoying her work and is busy baking for the Christmas holidays.

Blah, blah, blah, otherwise known as the BODY of the letter...

All in all we had a great year and we are anxiously awaiting Santa’s visit!! Have a Merry Christmas and a Happy New Year!

Love,

Mike
LESSON 6

This lesson is the last one based on the outcome in which students are to compose, revise, and edit text. Students become more familiar with the capabilities of a word processing program and then use various functions to complete a letter writing assignment which is also part of the Language curriculum requirements. At the end of this lesson a sample skills-based test is provided.

Key Category: *Processes for Productivity*

Converting Files and Connecting Various Features with Word Processed Letter

Writing

General Outcome:

P1. Students will compose, revise and edit text

Specific Outcomes:

2.1 create and revise original text to communicate and demonstrate understanding of forms and techniques

2.2 edit and format text using such word-processing features as the thesaurus, find/change, text alignment, font size and style to clarify and enhance meaning

Writing a Business Letter


2. Give it the name: *Business Letter info.*

3. Type the following information on the components and format of a business letter exactly as is seen.
To write an effective business letter, you must know your purpose, understand your audience, organize, and convey content clearly. Finally, present your letter in an attractive and conventional format.

Here is a list of information you may want to include in a business letter. Obviously, not every letter will require all of these elements:

1. Your specific request complaints, decision, action and so on.
2. Include all pertinent information - dates, times, quantities, and amounts
3. Be accurate. Indicate when any figures you use are estimates.
4. With certain kinds of inquiries or complaints you may want to include relevant serial numbers, identification codes or account numbers.

Components of a Business Letter

**Heading** - gives the writer’s complete address and date.

3624 199 St
Edmonton, Alberta
T8N 1Z8
January 5, 1996

**Inside address** - gives the full name and address of the person or firm to whom the letter is directed at.
Mr. Peter Peterson
Manager, Human Resources
Allen, Wrench, and Company
4367 Klein Avenue
Winnipeg, Manitoba
R3L 1B1

Salutation - the greeting appears below the inside address exactly on line below the inside address
i.e. Dear Mr. Peterson, or Dear Sir,

Body - the body of the letter appears below inside address

Closing - a complementary close is used at the end of the letter. Only the first word of the close is capitalized

Formal Closing:
Yours truly or Yours very truly

Less Formal:
Sincerely yours or sincerely

Signature - your signature should appear after the closing with your name typed underneath it.
4. Deleting Text

A: The Long Cut:

- On your document: Business Letter info, highlight point 1 found under “list of information you may want to include in a business letter.”
- Under the Edit Menu select cut
- All of point 1 should have disappeared
- Now make point one reappear by simply going back up to the Edit Menu and selecting Undo Cut

B: The Quick Cut

- On your document: Business Letter info, highlight point 1 found under “list of information you may want to include in a business letter.”
- Now press the Delete key
- Now make point 1 reappear. Simply going back up to the Edit Menu and selecting Undo Cut

C: The Undo Function

- Delete point 1 again.
- Now simply press the Space Bar.

The deleted material does not reappear because in ClarisWorks the Undo function only “undoes” the last function entered - in this case it was the creating of a space by pressing the Space Bar.
5. Copy and Paste

Copy and Paste are powerful and useful functions which let you work with document material within a document and between documents.

A: The Long Copy and Paste:

• On your document: Business Letter info, highlight point 2 found under “list of information you may want to include in a business letter.”
• Now go under the Edit Menu and select Copy.
  Point 2 will now be copied in memory and it is ready to paste.
• Move your pointer under point 4 and click once. Select Paste from the Edit Menu.
  Point 2 should now appear under point 4. The original point 2 will still be where it was.

B: The Short Copy and Paste (Hot Keys)

Notice that on the Edit Menu besides the functions copy and paste there is the apple swirl symbol (Command key) and a letter. If you hold down apple/command key and the letter C at the same time it will copy highlighted text. If you hold down the apple key and the V at the same time your text will automatically be pasted where you have placed your curser.
• Copy point three and past it under point two using these hot keys.
6. Delete all the points found under list of information you may want to include in a business letter.

7. Ruler and Margins

On the very top of your document just under your Document Menu Commands there is a ruler. If you look closely on the right hand side you will see a little triangle pointing towards the right. On the left you will find another triangle on its side, but it will be pointing to the left. These triangles indicate the left and right margins of your document.

- To make this ruler disappear all you have to do is select Hide Rulers from the View Menu. Do it now.
- To make it reappear simple select the View Menu again and select Show Rulers. Do it now.
- With your mouse highlight the inside address example which looks like this:

Mr. Peter Peterson
Manager, Human Resources
Allen, Wrench, and Company
4367 Klein Avenue
Winnipeg, Manitoba
R3L 1B1
• Now with the address still highlighted move your pointer to the left triangle.

• Move your pointer right on top of the triangle. Press your mouse button once and hold. Now drag the triangle across the ruler to the number three.

• Your inside address should have moved to the middle of the screen. Its left margin has now been set to 3”.

• Now set all the examples given under the parts of a business letter to a left margin of 3”.

• Now set the left margin for your entire document to 1.5”.

• Now set the right margin of your document to 7”.

• You can undo the margin format you selected by simply selecting Undo for the Edit Menu.

• Play with the margins of your document to see how small or how strange you can set them. Check to see how your text data is affected.

• Now set the left margin of your document to 1.5” and the right to 7”.
8. Center Justify the title.

9. Bold the following words in your document:

   Heading
   Inside Address
   Salutation
   Body
   Closing
   Formal and Less Formal

10. Insert a header into your document using Insert Header command.
    In this header, enter your name and the assignment #.

11. Save your file - You are finished!
Word Processing TEST

This will test the skills you should have learned and mastered by doing Word Processing Assignment so far.

*Start of Test*

Please read each sentence and follow the directions exactly as indicated:

1. Please align this sentence to right justification.

2. In this sentence bold each word that begins with the letter b and t.

3. Align this sentence to center justification.

4. Move this sentence between sentence number one and number two.

5. Next, I want you to insert as header into this document.
   - In the first line of this header I would like you to type out your full name.
   - On the second line of the header I would like you to enter today’s date.
   - Center justify all the information that you have entered in the header.

6. After deleting the threee from sentence 3 attach it to the end of this sentence.
7. Look at the top of this document. Change the font size of the word TEST 1 from 18 to 24.

8. In sentence number 5, bold every word that ends with an e.

9. Finally spell check this test, because there are a lot of mistakes. After spell checking, proof read the test for any other spelling mistakes that may have been missed.

- End of Test -

Now save the test on your disk under the name: Test 1
Please read each sentence and follow the directions exactly as indicated:

1. Please align this sentence to right justification.

4. Move this sentence between sentence number one and number two.

2. In this sentence bold each word that begins with the letter b and t.

5. Next, I want you to insert as header into this document.

   - In the first line of this header I would like you to type out your full name.
   - On the second line of the header I would like you to enter today’s date.
   - Center justify all the information that you have entered in the header.

6. After deleting the three from sentence 3 attach it to the end of this sentence. Align this sentence to center justification.

7. Look at the top of this document. Change the font size of the word TEST 1 from 18 to 24.
8. In sentence number 5, bold every word that ends with an e.

9. Finally spell check this test, because there are allot of mistakes. After spell checking
   proof read the test for any other spelling mistakes that may have been missed.

- End of Test -

Now save the test on your disk under the name: Test 1
LESSON 7

I did this activity with my class in the fall and they really enjoyed it. Concepts pertain to word processing and multimedia capabilities. Students develop a children's story and create a picture book.

Creating a Children's Story

General Outcome:
17 Students will use electronic research techniques to construct personal knowledge and meaning.

Specific Outcome:
2.2 use selected presentation tools to demonstrate connections among various pieces of information

Students could present using a LCD panel and even PowerPoint software if it is available to them. We don't even have a colored printer at our school, much less HyperStudio - but hopefully will next year!

Word Processing & Painting/Drawing TOOLS

Children's Story

Learning Objectives:
- using Tools within ClarisWorks 4
- cut, copy and paste within tool function
- ClarisWorks Library
- the Slide Projection function
Assignment:

Your objective is to create a *ClarisWorks document children's story book* on ClarisWorks 4. Your story will be for children who are between the ages of 5 and 8 years of age. The criteria for your story is as follows:

- Part One -

Content criteria for your story:

- must be suitable for children ages 5-7
- must contain a minimum of 3 pictures using **Tool functions** (excluding front cover)
- must contain 3 library graphic images from ClarisWorks **Library**
- must contain a minimum of **250 words** (excluding front cover).
- must be a minimum of 5 pages long
- must be well written
- must include a **front cover** (see below)

Criteria for front cover:

- must contain 1 picture created through **Tool functions**
- must include the title of the story
- must include the author’s name (your name)
Writing quality criteria:

• a high level of quality is expected with regards to spelling, grammar and paragraph structure.

Example of assignment:
LESSON 8

The next two lessons are based on the same outcomes. Students learn about spreadsheets in Lesson 8 and how to integrate and display data into a text document.

The Spread on Spreadsheets

General & Specific Outcomes:

P2 Students will organize and manipulate data.
2.1 enter and manipulate data, by using tools such as a spreadsheet or database for a specific purpose
2.2 display data electronically through graphs and charts

P4 Students will integrate various applications.
2.1 integrate a spreadsheet, or graphs generated by a spreadsheet, into a text document
2.2 vary font style and size, and placement of text and graphics, in order to create a certain visual effect

Using the Spreadsheet Environment

A spreadsheet is a computerized table designed to hold numbers and words. It contains many features that make it easy to automate computations on financial and other numeric data. Besides being used in accounting, spreadsheets are routinely used in math and the sciences. They are an excellent aid to representing a variety of problems from these areas and then helping to carry out the computations needed to solve problems. Think about situations in which you have organized a lot of numbers into tables in order to solve a problem. Chances are that in such situations a spreadsheet could have helped you.
In general, spreadsheet documents primarily contain numeric information. A spreadsheet document, or a spreadsheet frame, is a grid of rows and columns. The rows run horizontally (side-to-side) across the grid and the columns run vertically (up and down). A cell is formed at the intersection of each row and column. The shaded cell in this frame is numbered A1, it is column A and row 1. The name A1 is referred to as the cell address. The information contained within a spreadsheet can be printed in the form of nicely labelled tables. However it is often desirable to express the entries in a spreadsheet document in graphs and charts. The Spreadsheet Environment in *Claris Works* contains very powerful graphing and charting features that will be discussed later in this session.

**Getting Started:**

To begin working with the spreadsheet, open a new document.
Once upon a time there lived a happy boy. Like most young boys this age, he owned a dog.

Now this was no ordinary dog. There was something strange about this dog. To begin with the dog looked kind of funny! He had long stick legs and a fat body. He also had a long skinny neck and a really weird looking face. In fact, he even smelled kind of funny....

- Part Two -

Reading Expectations:

- Using the Slide Projection function you will present your story to an individual of the appropriate age. Yes that’s right... you will read you story to (or with) either a Kindergarten, Grade 1 or Grade 2 child.

Time:

- You will have 5 complete classes to complete this assignment. I will be evaluating your stories on the criteria stated above.

* Note: While some of you may get ambitious about using the paint functions you should know that if you create an image using a lot of detail you may run out of memory. Graphics take an incredible amount of memory. If I had created this document in ClarisWorks Paint I would need approximately 10 separate disks to save my file.
You see a table divided into rows and columns.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Spreadsheet Vocabulary

**columns** - are lettered A, B, C, and so on. (after the first 26 columns, they are lettered AA, AB, and so on.)

**rows** - are numbered 1, 2, 3, and so forth. Thus each *cell* in the spreadsheet can be identified by giving its column letter(s) and row number. Cell B5 is in the fifth row of the second column.

**current cell** - if you move the mouse pointer and click anywhere on the spreadsheet, a border appears around the cell you selected. This cell is called the *current cell*.

**cell address** - of the current cell appears in the upper left corner of the spreadsheet in the area called the *address box*. When you open a new spreadsheet document, the current cell is the first row of the first column. Its cell address, A1, appears in the Address box.
Getting Started:

To enter data into a spreadsheet, click on the cell you want to use. As you enter data, it appears at the top of the screen in the text box, called the *Entry bar*. You accept your entry by pressing Return.

If you do not want to keep your entry, highlight the current cell you wish to delete and press delete.
Create a spreadsheet with row and column headings (see Blue Jays Spreadsheet Assignment page 4). Grade 4 students can keep a record of what goes into school garbage and use their findings to do this as part of their Science unit "Waste and Our World". Grade 5's can use weather patterns and also integrate Science. You can press Return to move down a column, or you can press Tab to move across a row. You can also use the arrow keys to move to another cell. Moving to another cell also confirms your entry just as if you pressed return.

![Spreadsheet Image]

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>Player</td>
<td>HR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Sprague</td>
<td>36</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Carter</td>
<td>30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Delgado</td>
<td>25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Perez</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Olerud</td>
<td>18</td>
<td></td>
<td></td>
<td>130</td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Instructions: Since the Toronto Blue Jays won the World Series for the second time in a row in 1992, they have not had a winning record! They need to make decisions about what their team will be like in 1998. Unfortunately, the team computer specialist (Sparky Becker), does not know how to total up the statistics and to create graphs that can show the owners how the players performed for the 1997 season. Your task is to produce a report that will be given to the owners that contains information from the spreadsheet, word-processing, and graphics feature of Claris Works. The following is what you will be doing:

Order of Completing the Report:

1) Place a header on your report entitled “Toronto Blue Jays Individual Statistics, 1997” (Go to the Format menu, Insert Header). The Header will automatically appear on each page of your document.

2) In column A, type in the names of the players Carter, Olerud, Delgado, Perez, and Sprague. In column B type in their Homeruns (HR). See attached stats sheet on following pages.

3) Total up columns B =SUM(column and row..column and row).

    =SUM(B51..b55)

4) Create a bar graph illustrating the top five homerun hitters. Highlight the info. in your ss (exclude total).
• Go to the Options Menu, make chart, click on bar graph, click on Axes

![Chart Options window with options for gallery, axes, series, labels, and general settings.]

• Click on y axis - type **homeruns**

![Chart Options window with options for axis settings, including axis label, tick marks, grid lines, minimum, maximum, step size, and log settings.]

![Chart Options window with options for axis settings, including axis label, tick marks, grid lines, minimum, maximum, step size, and log settings.]

- H axis
- Y axis
- Axis label: homeruns
- Tick marks: Outside
- Grid lines
- Minimum
- Maximum
- Step size
- Log
• Click on Series - click on label data

![Chart Options dialog box with Series settings](image)

• Click on Labels - type in the title of your graph

![Chart Options dialog box with Labels settings](image)

• Click OK
A bar graph will appear on your spreadsheet.

![Bar Graph]

Select it, go to the Edit menu, Copy (or open apple c)

Go to File menu New (or open apple n)

Select a word processing document

Go to the View menu, Show Tools

Select the arrow tool

Go to the Edit menu, paste (or open apple v)

The graph will now be in your word processing document and you can enter text to answer the paragraph question at the end of the assignment. Save this file as Bluejays wp and return to your spreadsheet. Go to the View menu and scroll down to your previous document.
5) Create a **pie graph** showing the **top five players**. Choose one of these headings (R, RBI, SO, or SB%). Follow same steps for creating a bar graph only select pie graph under the **Options** menu, make chart.

6) Create a different graph using the top five players in your chosen area.

7) Paste both of these graphs in your Blue Jays wp word processing document.
   *Make sure your arrow key is selected from the tool palette.

8) *This step is optional - only if you want/have extra time.*

Upon completion of the above, write a paragraph that explains the information that you calculated from your spreadsheet. In your paragraph, explain the following:

> Which players should be kept and given a new contract for $3,000,000? Why should they be kept on the team? Use the information from the graphs and spreadsheet to justify your answer. Be specific and position your graphs around to explain your reasoning.
### 1997 Toronto Blue Jays Statistics

<table>
<thead>
<tr>
<th>Player</th>
<th>G</th>
<th>AB</th>
<th>R</th>
<th>H</th>
<th>2B</th>
<th>3B</th>
<th>HR</th>
<th>RBI</th>
<th>BB</th>
<th>S</th>
<th>OBP</th>
<th>SLG</th>
<th>AVG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perez, R.</td>
<td>86</td>
<td>202</td>
<td>30</td>
<td>66</td>
<td>100</td>
<td>2</td>
<td>21</td>
<td>8</td>
<td>17</td>
<td>25</td>
<td>.354</td>
<td>.406</td>
<td>.327</td>
</tr>
<tr>
<td>Nixon, O.</td>
<td>125</td>
<td>496</td>
<td>87</td>
<td>142</td>
<td>15</td>
<td>1</td>
<td>1</td>
<td>29</td>
<td>71</td>
<td>68</td>
<td>.377</td>
<td>.327</td>
<td>.286</td>
</tr>
<tr>
<td>*Cedeno, D.</td>
<td>77</td>
<td>282</td>
<td>44</td>
<td>79</td>
<td>10</td>
<td>2</td>
<td>2</td>
<td>17</td>
<td>15</td>
<td>60</td>
<td>.320</td>
<td>.351</td>
<td>.280</td>
</tr>
<tr>
<td>Green, S.</td>
<td>132</td>
<td>422</td>
<td>52</td>
<td>118</td>
<td>32</td>
<td>3</td>
<td>11</td>
<td>45</td>
<td>33</td>
<td>75</td>
<td>.342</td>
<td>.448</td>
<td>.280</td>
</tr>
<tr>
<td>Olerud, J.</td>
<td>125</td>
<td>398</td>
<td>59</td>
<td>109</td>
<td>25</td>
<td>0</td>
<td>18</td>
<td>61</td>
<td>60</td>
<td>37</td>
<td>.382</td>
<td>.472</td>
<td>.274</td>
</tr>
<tr>
<td>Delgado, C.</td>
<td>138</td>
<td>488</td>
<td>68</td>
<td>132</td>
<td>28</td>
<td>2</td>
<td>25</td>
<td>92</td>
<td>58</td>
<td>139</td>
<td>.353</td>
<td>.490</td>
<td>.270</td>
</tr>
<tr>
<td>Samuel, J.</td>
<td>69</td>
<td>188</td>
<td>34</td>
<td>48</td>
<td>8</td>
<td>3</td>
<td>8</td>
<td>26</td>
<td>15</td>
<td>65</td>
<td>.319</td>
<td>.457</td>
<td>.255</td>
</tr>
<tr>
<td>Brumfield, J.</td>
<td>119</td>
<td>388</td>
<td>63</td>
<td>99</td>
<td>28</td>
<td>2</td>
<td>14</td>
<td>60</td>
<td>29</td>
<td>75</td>
<td>.311</td>
<td>.446</td>
<td>.255</td>
</tr>
<tr>
<td>Carter, Joe</td>
<td>157</td>
<td>625</td>
<td>84</td>
<td>158</td>
<td>35</td>
<td>7</td>
<td>30</td>
<td>107</td>
<td>44</td>
<td>106</td>
<td>.306</td>
<td>.475</td>
<td>.253</td>
</tr>
<tr>
<td>Perez, T.</td>
<td>91</td>
<td>295</td>
<td>24</td>
<td>74</td>
<td>13</td>
<td>4</td>
<td>1</td>
<td>19</td>
<td>25</td>
<td>29</td>
<td>.311</td>
<td>.332</td>
<td>.251</td>
</tr>
<tr>
<td>Sprague, Ed</td>
<td>159</td>
<td>591</td>
<td>88</td>
<td>146</td>
<td>35</td>
<td>2</td>
<td>36</td>
<td>101</td>
<td>60</td>
<td>146</td>
<td>.325</td>
<td>.496</td>
<td>.247</td>
</tr>
<tr>
<td>O'Brien, C.</td>
<td>109</td>
<td>324</td>
<td>33</td>
<td>77</td>
<td>17</td>
<td>0</td>
<td>13</td>
<td>44</td>
<td>29</td>
<td>68</td>
<td>.331</td>
<td>.410</td>
<td>.238</td>
</tr>
<tr>
<td>Brito, T.</td>
<td>26</td>
<td>80</td>
<td>10</td>
<td>19</td>
<td>7</td>
<td>0</td>
<td>1</td>
<td>7</td>
<td>10</td>
<td>18</td>
<td>.344</td>
<td>.363</td>
<td>.238</td>
</tr>
<tr>
<td>Gonzalez, A.</td>
<td>147</td>
<td>527</td>
<td>64</td>
<td>124</td>
<td>30</td>
<td>5</td>
<td>14</td>
<td>64</td>
<td>45</td>
<td>127</td>
<td>.300</td>
<td>.391</td>
<td>.235</td>
</tr>
<tr>
<td>Mosquera, J.</td>
<td>8</td>
<td>22</td>
<td>2</td>
<td>5</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>3</td>
<td>.261</td>
<td>.318</td>
<td>.227</td>
</tr>
<tr>
<td>Martinez, S.</td>
<td>76</td>
<td>229</td>
<td>17</td>
<td>52</td>
<td>9</td>
<td>3</td>
<td>3</td>
<td>18</td>
<td>16</td>
<td>58</td>
<td>.288</td>
<td>.332</td>
<td>.227</td>
</tr>
<tr>
<td>Cairo, M.</td>
<td>9</td>
<td>27</td>
<td>5</td>
<td>6</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>9</td>
<td>.300</td>
<td>.296</td>
<td>.222</td>
</tr>
<tr>
<td>Crespo, F.</td>
<td>22</td>
<td>49</td>
<td>6</td>
<td>9</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>12</td>
<td>13</td>
<td>.375</td>
<td>.265</td>
<td>.184</td>
</tr>
<tr>
<td>Stewart, S.</td>
<td>7</td>
<td>17</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>4</td>
<td>.222</td>
<td>.235</td>
<td>.176</td>
</tr>
<tr>
<td>Huff, M.</td>
<td>11</td>
<td>29</td>
<td>5</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>5</td>
<td>.200</td>
<td>.241</td>
<td>.172</td>
<td></td>
</tr>
<tr>
<td>Player</td>
<td>BB</td>
<td>IBB</td>
<td>HP</td>
<td>SH</td>
<td>SF</td>
<td>GDP</td>
<td>SB</td>
<td>CS</td>
<td>SB%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>-----</td>
<td>----</td>
<td>----</td>
<td>-----</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perez, R.</td>
<td>8</td>
<td>0</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>6</td>
<td>3</td>
<td>0</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nixon, Otis</td>
<td>71</td>
<td>1</td>
<td>1</td>
<td>7</td>
<td>0</td>
<td>9</td>
<td>54</td>
<td>13</td>
<td>.806</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*Cedeno, D.</td>
<td>15</td>
<td>0</td>
<td>2</td>
<td>7</td>
<td>1</td>
<td>6</td>
<td>5</td>
<td>3</td>
<td>.625</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green, S.</td>
<td>33</td>
<td>3</td>
<td>8</td>
<td>0</td>
<td>2</td>
<td>7</td>
<td>5</td>
<td>1</td>
<td>.833</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Olerud, J.</td>
<td>60</td>
<td>6</td>
<td>10</td>
<td>0</td>
<td>1</td>
<td>10</td>
<td>1</td>
<td>0</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delgado, C.</td>
<td>58</td>
<td>2</td>
<td>9</td>
<td>0</td>
<td>8</td>
<td>13</td>
<td>0</td>
<td>0</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Samuel, J.</td>
<td>15</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>9</td>
<td>1</td>
<td>.900</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brumfield, J.</td>
<td>29</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>14</td>
<td>15</td>
<td>4</td>
<td>.789</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Carter, J.</td>
<td>44</td>
<td>2</td>
<td>7</td>
<td>0</td>
<td>6</td>
<td>12</td>
<td>7</td>
<td>6</td>
<td>.538</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perez, T.</td>
<td>25</td>
<td>0</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>10</td>
<td>1</td>
<td>2</td>
<td>.333</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sprague, Ed</td>
<td>60</td>
<td>3</td>
<td>12</td>
<td>0</td>
<td>7</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O'Brien, C.</td>
<td>29</td>
<td>1</td>
<td>17</td>
<td>3</td>
<td>2</td>
<td>8</td>
<td>0</td>
<td>1</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brito, T.</td>
<td>10</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>.500</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gonzalez, A.</td>
<td>45</td>
<td>0</td>
<td>5</td>
<td>7</td>
<td>3</td>
<td>12</td>
<td>16</td>
<td>6</td>
<td>.727</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mosquera, J.</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Martinez, S.</td>
<td>16</td>
<td>0</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cairo, M.</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crespo, F.</td>
<td>12</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stewart, S.</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Huff, M.</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* -- Traded
Spreadsheet Assignment: The Toronto Blue Jays

Instructions: Since the Toronto Blue Jays won the World Series for the second time in a row in 1992, they have not had a winning record! They need to make decisions about what their team will be like in 1998. Unfortunately, the team computer specialist (Sparky Becker), does not know how to total up the statistics and to create graphs that can show the owners how the players performed for the 1997 season. Your task is to produce a report that will be given to the owners that contains information from the spreadsheet, word-processing, and graphics feature of Claris Works. The following is what you will be doing:

Order of Completing the Report:

1) Place a header on your report entitled “Toronto Blue Jays Individual Statistics, 1997”

2) In column A, type in the names of the players.

3) Type in the headings that you will be using to make your graphs and charts:
   
   (G, AB, R, H, 2B, 3B, HR, RBI, BB, SO, AVG, SB%)

   (Check your numbers over after each completed column).

4) Total up the columns
   
   =SUM(column and row.. column and row).

Important: For every column that has decimals in it, your formula will include the following:

   =SUM(column and row..column and row)/number or rows.
5) Graphing (you will be making three):

   a) Create a **bar graph** illustrating the different **averages** between Carter,
      Olerud, Green, Delgado, Nixon, and Sprague. Your graph will have a Y-axis
      and X-axis label. Also, you will be making a legend.

   b) Create a **pie graph** showing home runs for the **top five players (HR)**.

   c) Choose one of these headings (R, RBI, SO, or SB%) and create a different
      graph using the top five players in your chosen area.

6) Upon completion of the above, you will be writing a paragraph that explains the
   information that you calculated from your spreadsheet.

   In your paragraph, you will explain the following:

   - Which players should be kept and given a new contract for $3,000,000?

   Why should they be kept on the team? Use the information from the graphs and
   spreadsheet to justify your answer. Be specific and position your graphs around to
   explain your reasoning.
Evaluation

You will be evaluated according to:

1) The accuracy of your spreadsheet-do the numbers match the sheet?
2) The correctness of your totals - are they correct?
3) Are your graphs correct? Do they correspond to the data from the spreadsheet?
4) Report-Do the paragraphs and information relate to the data? Are you creative in the way you present the report? (Use different fonts and size of letters, position your graphs in an organized manner, etc.).
Gr. 4 - ClarisWorks Spreadsheet Function

Spreadsheets allow users to add, subtract, multiply, and divide numbers. It also can do many of these operations at the same time, or in combination with other tasks.

Instructions

To activate the spreadsheet function, choose the “+” located in the second row of the tool bar. Then, just drag the box to form a spreadsheet as big as you need it.

1) Create a spreadsheet box that goes ten boxes down, and two boxes wide.

Example:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2) All columns are marked by letters, and rows are marked by numbers.

3) Each individual box is called a "cell".

4) You can select a cell by clicking on it with your pointer.
5) In your cells, put in the following information:

6) Below are four (4) formulas that you can use to add, subtract, multiply, and divide.

**Formulas:**
- Adding: =SUM(A1+A2)
- Subtracting: =SUM(A1-A2)
- Multiplying: =SUM(A1*A2)
- Dividing: =SUM(A1/A2)

Survey the class as to how many pets each student owns a keep a tally.

Use the proper formula to add up each of the number of pets all the children have altogether. Put the formula in cell B10.

**Hint:** You can add many numbers in a single row by using ".".

*Example = SUM(A1..A9)*
If your spreadsheet does not have 37 as the answer to the number of pets altogether, you must have put in the wrong formula.

Check the picture above. Does your formula for cell B10, look the same or different?

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Pets</td>
</tr>
<tr>
<td>2</td>
<td>Bill</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>Ben</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Brophy</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>Brady</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>Brody</td>
<td>7</td>
</tr>
<tr>
<td>7</td>
<td>Betty</td>
<td>5</td>
</tr>
<tr>
<td>8</td>
<td>Bob</td>
<td>4</td>
</tr>
<tr>
<td>9</td>
<td>Brian</td>
<td>5</td>
</tr>
<tr>
<td>10</td>
<td>Total</td>
<td>37</td>
</tr>
</tbody>
</table>

7) When you are putting in formulas, the secret is to make sure that the cells you want to add, subtract, or whatever, are accurately labelled. For example, since we wanted to add up all of the numbers in Column B, we used the formula =SUM(B2..B9). This added up all the numbers from Bill to Brian. Why didn't we include B1?

We can also make a graph of this information.

i) Highlight all of the cells from A2 all the way to B9, by clicking on A2, and dragging your mouse all the way to B9:

ii) Select "Make Chart" under the Options menu.

iii) You can choose to make a bar graph, or a pie graph. For this example, choose a pie graph.

iv) Your pie graph will not be exactly like the one on the next page, since that one has had some special features added. To add these features to your pie graph, experiment with some of the buttons in the "Make Chart" menu.
Hint: Double-click right on your graph to edit

or revise it.
YOUR ASSIGNMENT

You will create a spreadsheet, bar graph, and a written explanation to your parents that explain why you need a raise in your allowance. Please use friendly letter format from last class for the letter.

In your spreadsheet, create at least three columns. One of the columns should have the months of the year written, the second should have how much allowance you get each month, and the third should include how much money you spend a month.

You should have a "Total" box also, that shows how much money in total you make, and you spend, a year.

Remember, this is the minimum. You may be more creative, and add many more rows or columns to suit your purpose.

Good Luck and Have Fun!
LESSON 9

This lesson is based on the same outcomes as the above. Students learn about databases and how to integrate and display data into a text document.

The Data on Databases

General & Specific Outcomes:
P2 Students will organize and manipulate data.
2.1 enter and manipulate data, by using tools such as a spreadsheet or database for a specific purpose
2.2 display data electronically through graphs and charts

P4 Students will integrate various applications.
2.1 integrate a spreadsheet, or graphs generated by a spreadsheet, into a text document
2.2 vary font style and size, and placement of text and graphics, in order to create a certain visual effect

Using the Database

A database is a collection of information. You are familiar with a large number of nonelectronic databases. Printed telephone books and dictionaries are examples of databases. A card file of recipes or research notes is a database. Your personal address book, a class list, or a list of customers is a database.

Databases are made up of records. A record is a set of related data about a single item. For example, a database of addresses would have one record for each person. The record might contain the name, street, city, province and postal code associated with a certain person.
A record is divided into one or more categories of information, called fields. Thus, a database of addresses would have at least five fields: name, street, city, province, and postal code.

When a database is stored electronically, it is easy to use the computer to access, search, and sort the information. Technically, computer programs that allow the manipulation of data in a database are called database management systems. However, the word *database* is commonly used to refer both to the collection of information and to the software used to work with the collection of information.

**Getting Started:**

In this exercise you will be creating a small database of ten records when completed. The database will be of the following information:

<table>
<thead>
<tr>
<th>First Name</th>
<th>Last Name</th>
<th>Address</th>
<th>City, Place</th>
<th>Postal</th>
<th>Ph. #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allan</td>
<td>Peters</td>
<td>5618-32 St.</td>
<td>Rockerville, AB</td>
<td>H4K 5J6</td>
<td>456-1234</td>
</tr>
<tr>
<td>Doug</td>
<td>Slug</td>
<td>14 Martins Dr.</td>
<td>Cascade, Ohio</td>
<td>756890</td>
<td>811-2345</td>
</tr>
<tr>
<td>Henry</td>
<td>Fonda</td>
<td>185 Green St.</td>
<td>Hollywood, CA</td>
<td>553285</td>
<td>444-3456</td>
</tr>
<tr>
<td>Henry</td>
<td>Hedges</td>
<td>81 Red Avenue</td>
<td>Mellonville, AB</td>
<td>T4N 7T8</td>
<td>888-7890</td>
</tr>
<tr>
<td>Jane</td>
<td>The Pain</td>
<td>#30 3815-14 St.</td>
<td>Mellonville, AB</td>
<td>T4N 4J6</td>
<td>888-0123</td>
</tr>
<tr>
<td>John</td>
<td>Hedges</td>
<td>35 Sandbox Dr.</td>
<td>Hedge Hog, Kan</td>
<td>45879</td>
<td>999-2233</td>
</tr>
<tr>
<td>Martha</td>
<td>Muffin</td>
<td>81 Red Avenue</td>
<td>Mellonville, AB</td>
<td>T4N 3J7</td>
<td>888-3344</td>
</tr>
<tr>
<td>Peter</td>
<td>Pan</td>
<td>78 Blue Road</td>
<td>Landau, Ohio</td>
<td>56980</td>
<td>987-4455</td>
</tr>
<tr>
<td>Peter</td>
<td>Samsonite</td>
<td>16 Luggage Lane</td>
<td>Tourist Trap, Ohio</td>
<td>56870</td>
<td>321-5566</td>
</tr>
<tr>
<td>Sally</td>
<td>Muffin</td>
<td>15 Norwood St.</td>
<td>Maples, Tex</td>
<td>46789</td>
<td>888-6677</td>
</tr>
</tbody>
</table>
To begin working with the database file, go to FILE, NEW, Database, OK.

You will then see a dialog box requesting that you Define Fields.
The edit bar is automatically positioned in the Name field. Type **First Name** in this area and click on Create. You will then be requested for a second field name (LAST NAME) and so on until you have entered all seven fields (fields are like column headings or categories). Click on Done when you have entered all the fields. You will be placed in the first data entry area (First Name of the first record in your database).

![Define Database Fields](image)

**NOTE:** If you have already pressed the DONE button and need to edit your field names, go to Layout, Define Fields. Click on the field you want to change and either make the appropriate changes in the edit area, or Delete or Modify the fields as needed.
Having entered your fields, you are now ready to enter your record information (records are a single set of related data, data that is always kept together - for example, all the information relating to Henry Fonda). The upper left-hand corner of the workspace window should indicate that you are ready to enter information into the fields for record number 1. To enter information for a person’s first name in record 1, type Allan in the space provided beside the field name **FIRST NAME**. When you press [tab], the cursor will advance down to the next field name space (**LAST NAME**) and so on until you have finished all of the information necessary for record number 1. As you press [tab] for the last field in record 1, ClarisWorks will advance you to the first field of that same record. Also, pressing Shift-Tab will move you up through the fields one at a time if you need to edit any of the data. To create a New Record, choose **New Record** under the **Edit** menu.

<table>
<thead>
<tr>
<th>First Name</th>
<th>Allan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Peters</td>
</tr>
<tr>
<td>Address</td>
<td>5618-32 Street</td>
</tr>
<tr>
<td>City</td>
<td>Rockerville</td>
</tr>
<tr>
<td>Place</td>
<td>Alberta</td>
</tr>
<tr>
<td>Postal Code</td>
<td>H4K 5J8</td>
</tr>
</tbody>
</table>

3) Another way of thinking about databases is that they are a table of information. There are as many columns in the table as there are fields and there are as many rows in the table as there are records. The headings on the columns are the field names. To create this view of your database in ClarisWorks you need to create a new **Layout**. To do that, go to **Layout, New Layout, Columnar Report, OK**.
You may define the order in which fields should appear in the columns of a layout. You define this in the Set Field Order dialog box. Selecting too many fields in this dialog box may cause the headings and data in your columnar report to wrap around to the next line, rendering the layout difficult to read. If you anticipate more columns than the width of your page, use Page Setup (File menu) to set your page orientation to landscape (horizontal) mode. You should now see your data as a table of columns.

Save your database under a new name (to create a second working copy) to experiment with. You can change font, size, and style of either individual words or letters, or complete fields. To make the changes for individual words or letters experiment with these tools while in Browse mode (under Layout). To change any of these characteristics for an entire field, experiment with these tools under Layout mode.
<table>
<thead>
<tr>
<th>Name</th>
<th>First Name</th>
<th>Last Name</th>
<th>Address</th>
<th>City, State, Zip</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allan</td>
<td>Peters</td>
<td></td>
<td>5618-32 St. Rockerville, AB</td>
<td>H4K 5J6</td>
<td>456-1234</td>
</tr>
<tr>
<td>Doug</td>
<td>Slug</td>
<td></td>
<td>14 Martins Dr. Cascade, Ohio</td>
<td>756890</td>
<td>811-2345</td>
</tr>
<tr>
<td>Henry</td>
<td>Fonda</td>
<td></td>
<td>185 Green St. Hollywood, CA</td>
<td>553285</td>
<td>444-3456</td>
</tr>
<tr>
<td>Henry</td>
<td>Hedges</td>
<td></td>
<td>81 Red Avenue Mellonville, AB</td>
<td>T4N 7T8</td>
<td>888-7890</td>
</tr>
<tr>
<td>Jane</td>
<td>The Pain</td>
<td></td>
<td>#30 3815-14 St. Mellonville, AB</td>
<td>T4N 4J6</td>
<td>888-0123</td>
</tr>
<tr>
<td>John</td>
<td>Hedges</td>
<td></td>
<td>35 Sandbox Dr. Hedge Hog, Kan</td>
<td>45879</td>
<td>999-2233</td>
</tr>
<tr>
<td>Martha</td>
<td>Muffin</td>
<td></td>
<td>81 Red Avenue Mellonville, AB</td>
<td>T4N 3J7</td>
<td>888-3344</td>
</tr>
<tr>
<td>Peter</td>
<td>Pan</td>
<td></td>
<td>78 Blue Road Landau, Ohio</td>
<td>56980</td>
<td>987-4455</td>
</tr>
<tr>
<td>Peter</td>
<td>Samsonit</td>
<td></td>
<td>16 Luggage Lane Tourist Trap, Ohio</td>
<td>56870</td>
<td>321-5566</td>
</tr>
<tr>
<td>Sally</td>
<td>Muffin</td>
<td></td>
<td>15 Norwood St. Maples, Tex</td>
<td>46789</td>
<td>888-6677</td>
</tr>
</tbody>
</table>

- Change the font to something other than Times New Roman
- Change the text size to something other than 12 point
- Noticing the changes, you may prefer to return the font and size selections back to their original (default) settings
- Modify, in anyway you wish, the field attributes for any field (try the Alignment and Style selections under the Format menu)

Experiment with changing field widths and locations. While in **Layout** mode, using the mouse, try to change the width of the fields. Do this by clicking on the field you want to change and drag the "handles" (the little squares that appear when you click on the "objects." in the Layout window) to where you want them to be. You use this Layout window to set up your tables for printing.

Using the mouse, try to change the position of the fields by moving your mouse pointer to the field you wish to move and dragging the field name to a different location. Releasing the mouse when the field has been moved will reposition the entire field.
Select the Sort Records command from the ORGANIZE menu and sort the FIRST NAME and LAST NAME fields from A to Z (ascending order) and Z to A (descending order) respectively. You must move the desired field over to the Sort Order window and choose either ascending or descending order. Notice what happens to all of the information associated with a record that has moved. Notice that the database considers these numbers as text (i.e. of no mathematical significance). Change the field attributes for this field Define Fields (under the Layout menu) and then try to sort the field information numerically. Experiment with the different ways numbers can be displayed.

![Set Field Order](image)

Field List
- First Name
- Last Name
- Address
- City
- Place
- Postal Code

Field Order
- First Name
- Last Name
7) Suppose that you wanted a layout of your database information consisting of Last Name, First Name, and Phone Number. Create a new view by going to the LAYOUT menu, choose COLUMNAR. MOVE those three fields into the FIELD ORDER window by selecting the field name and clicking on MOVE in the order that you want the fields to be displayed on your layout. A layout is a selected portion of a database for the purpose of viewing and printing only related records that meet a specified criteria. Notice that since the database has no specific rules describing what to select, the database selects and displays all records. Because "Layout 1" is not a very descriptive name, change the name of your layout to something more appropriate (e.g., Names and Phone # Mark) by selecting that layout from the bottom of the LAYOUT menu and going to LAYOUT INFO.... Then you can enter the name of your choosing. From that time on, you can select various layouts from the bottom of the LAYOUT menu by the appropriate name.
8) The addresses can easily be printed on to labels that feed into a printer. Choose **New Layout** from the **Layout Menu**. Choose **Labels** and select the custom size or a preset Avery label.

![New Layout dialog box](image)

After this, set the **Field Order** by clicking (moving) the Fields you would like in your mailing label. Choose **Layout** to resize and move your fields into proper alignment for your mailing labels. Choose **Browse** to see actual record data.

![Label Layout dialog box](image)
Mail Merging is a process in which you link a word processing document with a database document. The purpose is usually to create a form letter (WP document) for each person in a mailing list (DB document). Ultimately, everyone on your mailing list would receive an identical personalized correspondence. The procedure is as follows:

1. Open or create your correspondence using Claris Works word processor (your family newsletter or class newsletter). This process also assumes you have already created a database which holds your mailing list.

2. While in the word processor, click on File...Mail Merge. Claris works then asks you to open an existing database (your mailing list) to link with your word processing document. Open this database.

3. A smaller mail merge dialog box should appear containing your field names from your database.

4. While in your word processor document click in the appropriate area to link your first names, last names, etc from your database. This is done by clicking at the proper line in your word processing document and then clicking on the "Insert Field" button from the mail merge dialog box.
5. Insert the proper number of fields into your word processing document. As you do this you will see "place holder" field name appear as you insert fields. To see the actual data, click on "Show Field Data" from the mail merge dialog box. You will then see the first record of information merged into your database. You can click through each record to see them appear in your word processor document.

6. Click on "Print Merge" from the mail merge dialog box. Remember that a form letter for every person in our database will be printed.
LESSON 10

This final lesson focusses on where the most attention is being directed - the internet - in the computer arena today. Educational url's are provided. Students explore the internet and use the information they acquire from it and other electronic sources meaningfully.

*Inquiry, Decision Making and Problem Solving*  
*Using the Information Highway Effectively*

1. Students will access and use information from a variety of technologies.
2.1 access and retrieve appropriate information from the Internet by using a specific search path or given uniform resource locations (URLs)
2.2 organize information gathered from the Internet or an electronic source by selecting and recording the data in logical files or categories

In this lesson students will explore search engines and URLs to locate information and examine the use of bookmarks and downloading and organizing of files.

Students can access information in a variety of ways in order to meet this outcome. Information pertaining to any topic in grade 4, 5, or 6 can be gathered via the telephone, fax, or computer.
When using the Internet to access and make use of information, it is important to know where you’re going (what you’re looking for) and how you’re going to get there (what to do to find required information). As Carroll notes, “Most people don’t go on a trip without a road map and they shouldn’t go on the information highway without the proper search engine” (1994, p. 7). Without having a clear path to follow when accessing information, students, and teachers, will encounter a lot of miscellaneous data which doesn’t necessarily support their intended search. The internet has been likened to a “library that has no card catalog” (Ryder, 1995, p. 2). Unless you have a specific search engine and a key word or phrase to give students that will take them directly to where they need to go on the net, it is best to have specific URLs to provide them with.

Developing an efficient method of searching the internet to find information on focused topics rather than trying to follow hyperlinks and narrow down searches on one’s own takes time. There is a plethora of sites available to educators. To support specific topics, some time has to be taken by the teacher or reliable students to find relevant sites. Often URLs are regularly included in newspapers, magazines, and radio and television segments. Some general sites to help you get started are listed on the following pages:
- www.schoolnet.ca
- www.acmepet.com
- www.econet.apc.org/econet/
- www.ellesmere.ccm.com.emr.ca/ourhome
- ted.edu.sfu.ca/expo/Resources.html
- sunsite.unc.edu/wm/
- k12.cnidr.org:90/
- www.rockyview.ab.ca/bpeak/
- ericir.syr.edu/
- www.2Learn
- 204.96.11.210/kidz/
- www.OnRamp.ca/~lowens/107kids.htm
- www.calgaryscience.ca/
- www.ucalgary.ca/~dkbrown/index.html
- www.bbp.com/edpsych/intres.html
- www.npac.syr.edu/textbook/kidsweb/
- www.chaos.com/learn/index.html
- www.exploratorium.edu/
- www.gov.pe.ca/educ/lester/index.html
- www.lloyd.com/k12index.html
- nyelabs.kcts.org/
- www.zen.org/~brendan/kids.html
- www.syllabus.com/top40.htm

99
- members.aol.com/zoonetkids/index.htm
- db.cochrane.com/db_HTML:theopage.db
- pds.ipl.nasa.gov/planets/
- www.spaceday.com.home.htm
- www.geo.mtu.edu/weather/aurora/
- www.reidmore.com/titles/sarcee.html
- tyrrell.magtech.ab.ca/home.html
- volcano.und.nodak.edu/
- www.indigenart.com/
- www.schoolnet.ca/ext/aboriginal/
- www.nesbitt.com/poetry/poems.html
- www.classroom.net
- www.gsh.org
- mcrel.org
- www.education-world.com
- www.exploratorium.edu
- www.babelfish.com/travel.ab.ca/alberta2.html
- www.canoe.com
- www.discoveralberta.com/
- www.quebecweb.com/
- www.ab.ec.gc.ca/ENGLISH/
- www.edgeinternet.com/angeles/sckids.html
- www.epa.gov/recyclecity/
- www.canada.com/canada/members.html
- www.jpl.nasa.gov/galileo
- www.ajkids.com
- www.pbs.org
- eardthday.wilderness.org
- www.cuug.ab.ca:8001/VT/Tyrrell
- www.greyware.com/authors

seds.lpl.arizona.edu/nineplanets/nineplanets/nineplanets.html

Keep in mind that sites may be “under construction” and not available when you attempt to search them. Usually a message as to when the site will be back on accompany this note. If you encounter the error message Unable to locate server... it may mean that the URL has changed, the site has been discontinued, or that the URL was typed in incorrectly - double check. This is a great way to get students to proofread what they’ve copied! If Server down - try again appears when you enter a URL, the computer/server on the other end is more than likely down and you need to try again later.

To use the Netscape icon an display window, enter the keyword(s) in the URL box and select the SEARCH button by using your mouse or pressing return. The Netscape icon will have comets streaking in it during the search. When all the information has been gathered your Netscape icon should be motionless. Only an “N” should be present.
Your display window should change from your Search Engine Home Page to:

- a summary of search results and locations where the information was gathered

- a search engine screen with all the sites located in a descending order according to relevance of information requested.

2.2 organize information gathered from the Internet or an electronic source by selecting and recording the data in logical files or categories

URLs can be saved using Bookmarks or Favorites. In order to organize bookmarks, go to **Windows** on the menu bar of *Netscape*. Within **Item** (from the Bookmarks menu) select **insert folder** and label the folder so that it can be used to keep like sites together. In order to file bookmarked URLs in the folder you created, simply drag the indicated sites into the appropriately titled folder. This is a lot like saving files other than internet sites!
Students will seek alternative viewpoints using information technologies.

2.1 seek responses to inquiries from various authorities through electronic media

I will be addressing this outcome instead of 13 due to firewalls. Students should be able to research email addresses and send messages pertaining to the curriculum but would probably have trouble using chatlines/newsgroups in most districts.

Fax machines and even telephones can be used as a starting point for students contacting various authorities. An excellent means of students exchanging information with other schools can be accessed at:

- web66.coled.umn.edu/school/Maps/Canada.html

This link from EdWeb enables you to access schools that have websites registered (Malone, p. 73).

Emails and other responses depend on the type of inquiry students are conducting and to whom it is directed. Email addresses may have to be collected personally in order to get information from authorities in that fashion. Perhaps a telephone call inquiring about one’s email address would be the first step in this process. Students could also be required to find email addresses in print when considering exchanging questions and answers in this manner. Another way to find out email addresses is to look on the web. For information regarding waste management, students could be directed to www.edgeinternet.com/angeles/sckids.html or www.epa.gov/recyclecity/ and then formulate meaningful inquiries based on questions which were not answered when reviewing the site.
2.1 access and retrieve appropriate information from the Internet by using a specific search path or given uniform resource locations (URLs)

NB - when studying Penguins with Division I students, we typed in “penguins” in various search engines. The majority of hits pertained to the Pittsburgh Penguins and there was of course a couple of pornographic referenced sites listed in the top results. Many seemingly innocent search words bring up inappropriate information even when stations are protected by a firewall. That is why it is important to know exactly what phrases students are to enter and where it will take them. This way students will see how to conduct a search without accessing unnecessary sites. This process is more teacher-directed and closed in order to keep a tight rein on what material appears on students’ screens. A “Kids on the Web: Safety on the Net” site can be found at www.zen.org/~brendan/kids-safe.html

It offers links to a number of popular software packages available that “try to help keep children safer on the Internet”. The site’s introduction continues that “while there is no ideal solution, as with life in general, the packages help take a first step to protecting children in Cyberspace.”

I will be addressing this outcome instead of I3 due to firewalls. Students should be able to research email addresses and send messages pertaining to the curriculum but would probably have trouble using chatlines/newsgroups in most districts. Have students use block and other forms of letters to help reinforce these L.I.L. requirements.